
HyperSenseÒ

Hypermedia Authoring for Everyone!

This README file contains a description of what HyperSense is, and contact 
information for obtaining answers to any questions you may have.    This file 
also describes how to install the accompanying copy of HyperSense and explore
the included demonstration documents in order to learn firsthand about some of
HyperSense's capabilities.

Note: The current release of HyperSense (version 1.00B10b) is distributed in 
Multi-Architecture Binary format for Intel and Motorola computers.    The release 
comes in the form of two Installer packages: HyperSenseApp.pkg and 
HyperSenseDocs.pkg.    While it is possible to run HyperSense and use most 
of the documents available by FTP with only the first package installed, several 
features of the program are limited or unavailable unless the essential 
documents contained in the second package are installed as well.    To fully 
evaluate HyperSense, you should obtain and install both packages.

Obtaining More Information
HyperSense is a ThoughtfulÔ Software product. 



Thoughtful Software phone: (303) 221-4596
616 E. Locust Street fax: (303) 221-0841
Fort Collins, CO    80524 email: info@thoughtful.com

What is HyperSense?
HyperSense is the HyperCardÒ-compatible authoring environment that unlocks 
the power of NEXTSTEP for everyone.    It lets you make your own Interactive 
Documents.

What is an Interactive Document?

A HyperSense Document can be as simple as a one-page memo or as complex 
as a complete multimedia application.    Here are some ideas of things you can 
do:

· Create Hypertext Books
· Design Educational Courseware
· Construct Software For Yourself And Others
· Prepare Multimedia Presentations
· Develop Interactive Business Training Systems
· Create Flexible Personal Databases
· Lay Out And Publish PostScript Documents



By simply dragging buttons, fields, graphics and other elements into place, you 
can create Interactive Documents like these:

· Your own Custom Database or Multimedia Catalog, complete with pictures, 
sounds and text.

· An Interactive Book, which lets you click on "hot" areas of a picture or 
page to jump to another page, show pictures or play recorded sounds.

What about complete multimedia applications?

The SenseTalkä scripting language gives you the power and flexibility you 
need to create sophisticated applications.    Yet SenseTalk's power is easy to use.
SenseTalk scripts are similar to standard English, making them easy to read, 
write, and understand.    For example, the script command for a button that 
takes a reader to the next page of a document is simply "go to the next page".   
We don't think you'll find an easier scripting language anywhere.    As 
NeXTWORLD magazine said in it's review of HyperSense, "Thoughtful Software 
has pulled off a real coup in providing NEXTSTEP users with such an accessible 
programming language."

Is HyperSense just for programmers?

No.    It's true that experienced programmers will find HyperSense to be a useful 
tool for developing both prototypes and finished applications, quickly and easily.



But HyperSense is not designed primarily as a programming tool.    HyperSense 
offers different things to different people.    As a general-purpose tool for 
creating and manipulating multimedia documents and applications it can serve 
the needs of many different types of users.    Many types of documents can be 
created without any scripting at all, by simply dragging the needed elements 
onto a page, including pre-scripted buttons, fields, and graphics.

When custom scripting is needed, our comprehensive online help system 
(created with HyperSense), and the ability to easily copy and modify pre-written
scripts, will have you creating your own applications in no time ± even if you 
don't know anything about programming.    Celia Duffy, who uses HyperSense to
create detailed music tutorials at Glasgow University writes "Not everyone has 
the expertise or need to program with Objective-C and Interface    Builder... 
that's why us ordinary non-programming mortals choose HyperSense as our 
preferred authoring software."

By combining a rich document architecture with the ease of drag-and-drop 
creation, plus a versatile, English-like scripting language, HyperSense offers a 
unique combination of power, flexibility, and ease of use that is unmatched by 
any other program.

What else?

Well...



If you've ever wished for software that would enable you to create a document
that was not merely text and graphics, but could interact with the reader;

if you've ever used a program that was almost just what you needed, but you 
wished you could make a few changes to make it fit your needs;

if you've wanted a program that would allow you to easily create a database 
for storing and organizing your information, but would give you the 
flexibility to change the structure at any time, including the ability to have 
different sets of data items on different records;

if you've ever had ideas for programs you'd like to see, but didn't have the 
time or inclination to learn an arcane programming language in order to 
create them yourself;

if any of these ring true for you, or if you simply wish you had a program that 
would let you experiment with different ideas and quickly develop 
prototypes...

... then HyperSense was created with you in mind.

Why not take a look and see for yourself what HyperSense can do!



Installing the Demo Release
The version of HyperSense contained in this demo release is the complete 
application, in Multi-Architecture Binary (MAB) format for both Intel and 
Motorola machines.    To install and use the HyperSense demo release 
effectively, you will need to install both the application (contained in 
HyperSenseApp.pkg) and the accompanying documents, including the online 
manual and other sample documents (contained in HyperSenseDocs.pkg).

Installing these two packages will create the HyperSense.app application in your
Apps or LocalApps directory, and a HyperSense subdirectory within your Library 
or LocalLibrary directory.    Altogether, the two packages require around 8.5MB 
of disk space when installed for a single architecture, or slightly more than 
10MB if installed "fat".

Before you install HyperSense:
If you have an earlier version of HyperSense installed on your system, you 
should remove it before installing this release, following steps A, B, and C below.

A. Preserve any files that are part of the original distribution which you have 
modified or would like to keep, by copying them to another directory.    In 
particular, unless you have your installation code recorded elsewhere, you 



may want to copy the License or NetworkLicense file located in 
HyperSense.app.    The installation process should leave these files 
undisturbed, but just in case the entire HyperSense.app directory gets 
deleted it may be handy to have a copy of the license file elsewhere.

B. Remove the earlier version of HyperSense by locating the package receipts
in the /NextLibrary/Receipts directory.    Double-click each one and click the
"Delete" button in the Installer window that appears.    You will need to be 
logged in under the same account which installed the packages in order to 
be able to delete them.

C. Remove or rename your Home document (Home.sense, located in your 
home directory, or other directory specified in your HyperSense HomePath 
default).    This will allow HyperSense to create a new Home document for 
you, containing any new changes or additions made to the Home 
document since the last release.

To install HyperSense:
1. Double-click HyperSenseApp.pkg.    This should launch the Installer 

application.    Note: If you received the distribution as a .tar file from an FTP
site, you may need to first select "Decompress" from the "File" menu in the
workspace in order to get the .pkg file.



2. Click the Install button and select the directory where you would like to 
install the HyperSense application.    You should install it either in your 
personal Apps directory (~/Apps), or in /LocalApps.    This will install 
HyperSense.app in the selected directory.

3. Double-click HyperSenseDocs.pkg (from the second part of the 
distribution).    Install this package in your personal Library directory 
(~/Library), or in /LocalLibrary.

This package will install a HyperSense directory in the selected Library.    
The HyperSense directory will have five subdirectories within it:    
DemoDocuments, LocalDocuments, MainDocuments, ReleaseNotes,
and XModDevKit.

The MainDocuments directory contains the on-line manual (Help.sense), 
the tour of HyperSense (HSTour.sense), the document creation tools 
(DocumentTools.sense), the Importer (Importer.sense), and the Other Tools 
palette (OtherTools.sense).

The DemoDocuments directory contains a number of sample HyperSense
documents.

The LocalDocuments directory is empty.    It is for your own use for 
documents that you create.    Along with the MainDocuments and 



DemoDocuments directories, it is included in the default search path as 
one of the known places where HyperSense will look when searching for a 
document.

The ReleaseNotes directory contains the latest release notes and 
README files for the current release.    Please read this information, and 
keep it as a supplement to the on-line documentation. 

The XModDevKit directory contains documentation, header files, and 
examples describing how to develop external modules to extend the 
SenseTalk language.    See the file XModules.README in this directory for 
more information.

If you have previously added your own files or documents in any of these 
directories, they should not be harmed by the installation process, unless 
the new release happens to contain new documents by the same name.    
In this case the installer will warn that some files already exist.    Before 
continuing, check the Log View carefully to see that nothing important will 
be overwritten by the installation process.

4. Launch HyperSense by double-clicking HyperSense.app in your ~/Apps 
or /LocalApps directory.    You may want to drag the HyperSense icon into 
your Dock to make it easily accessible in the future.

5. When the Welcome panel comes up, wait until the buttons at the bottom of



the panel are enabled (turn from gray to black).    To register your copy, 
click the button labeled "Register", enter your registration information and 
license key in the panel that appears, and then click "Register" in that 
panel.    The next time you launch HyperSense, the Welcome panel should 
go away by itself after a few seconds.

If you do not have a license key (i.e., if this is a Demo copy), you will have 
to click on "Demo Mode" each time HyperSense is started.    A panel which 
briefly describes the restrictions of Demo mode will be displayed (see 
below).    Click the "OK" button in this panel to proceed.

The first time you run HyperSense you should be presented with an alert panel 
indicating that a Home Document (Home.sense) does not exist, and asking 
whether you would like to create one.    Click the "Create" button in this panel.

Important Note:    If the "Home.sense" alert panel is NOT displayed the first 
time you launch HyperSense, but instead a Home document is displayed 
without the alert panel ever appearing, it indicates that you already had a Home
document, possibly from an earlier release of HyperSense.    If this happens, quit
HyperSense and remove the old Home.sense file from your home directory, 
then restart HyperSense and follow the steps outlined above.    This will ensure 
that you are using the Home document included with the demo package and 
will be able to access the demonstration documents.



Demo Mode Restrictions, and Limitations of This Release

The primary restriction placed on the use of HyperSense in Demo mode is that 
every document is treated as read-only.    HyperSense gives full access to read-
only documents, allowing text to be entered and changes to be made to the 
document without restriction.    However, the changes are never saved to the 
disk, so the next time the document is opened it will be exactly as it was at the 
start of the session.    A small padlock icon is displayed in the title bar of each 
read-only document to remind you that any changes you make will not be 
permanent.

For the most part, you will be able to take full advantage of HyperSense and the
demo documents included in the package.    For example, the PasteMaster 
document can be fully used in Demo mode as a multi-entry, multi-page auxiliary
pasteboard ± simply click one of the "Store" buttons to record whatever is 
currently on the system pasteboard for later use.    Click the "Use" button to 
restore an entry to the pasteboard, ready to be pasted into any document of 
any application.    However, the entries will be lost when you close the 
document.    When using a licensed copy of HyperSense, this would not be the 
case, and you could store any number of entries permanently, for later re-use.

This is a pre-release version of HyperSense.    In this release, portions of the 
online manual (particularly those dealing with SenseTalk) are incomplete.    The 
SenseTalk Browser (available from the Tools menu and from a button at the top 
of Script windows and the SenseTalk chapter of the online manual) gives a brief 



but thorough overview of the language.    A good book on HyperTalk will provide 
more details on most commands.    This release also contains only a limited set 
of sample documents, and does not include the full utilities for translating 
HyperCard Stacks into HyperSense Documents.

If you'd like to evaluate HyperSense more fully, contact Thoughtful Software and
request a temporary evaluation license key, which will remove most of the 
limitations of this release, allowing you to create and modify documents.

Accessing the Included Demo Documents
Most of the demonstration documents included with this release are directly 
accessible from buttons located on the two pages of the Home document.    
Simply click any of these buttons to open the associated document.    A few 
additional documents may be accessed from buttons within other documents, 
so all of the demo documents may be accessed (either directly or indirectly) 
from the Home document, if you do a little exploring.

A variety of different documents have been included, to give you a feel for some
of the many things HyperSense can be used for.    These should not be 
considered an exhaustive sampling by any means, but merely a glimpse of the 
possibilities.    If you are wondering whether HyperSense would be useful for a 
particular purpose but don't see anything similar presented here, please call us 



(303-221-4596), or send a question by e-mail (to info@thoughtful.com), and we 
will do our best to realistically assess how well-suited HyperSense is for your 
particular needs.

To begin learning about HyperSense, a good place to begin is with the Tour of 
HyperSense, which provides a brief introduction to HyperSense and the tools 
available to you.    Once you have explored in it thoroughly, you may browse 
freely through the other available documents.    After you've gotten a feel for 
what it's like to use HyperSense documents, you may want to try creating your 
own.    The online manual contains a short tutorial (Chapter 4) that will help you 
get started (note:  this tutorial is slightly out of date and has not yet been 
rewritten to take advantage of the recently added DocumentTools palette).    
Please remember that nothing will be saved to disk when using the program in 
Demo mode, so you will need to complete the entire tutorial within a single 
HyperSense session, or else start over at the beginning if you must return to it 
at a later time.

Note:    A few of the sample documents will not work well on machines with 
small screens (less than 1024 x 768 resolution).    These have been noted in the 
descriptions of the documents below.

The HyperSense documents included with this distribution are:

Addresses.sense



This document is a useful address book and includes such features as 
marking of individual pages or sets of pages, sorting by the contents of any 
field, and creation of mailing labels.    Please keep in mind that data entered 
while running in Demo mode will be lost when the document is closed.

Bookmarks.sense
This document enables you to create and maintain a list of markers which 

will take you directly to any page of any document by simply double-clicking on 
the marker in the list.    A separate list of bookmarks is maintained for each user.

DDM.sense
This Defaults Database Manager is a graphical front-end to the NEXTSTEP 

defaults database (an included help page explains its use in more detail).    DDM
illustrates one use of the SenseTalk doShell command to interface with UNIX 
command line utility programs.

DemoAddressBook.sense
This document is a simple example of a database type of application for 

storing names and addresses and other contact information.    Notice that the 
first page has a button labelled "Map" which does not appear on the other 
pages.    Clicking on this button brings up the document called "Map.sense".    
Also notice that some pages have TIFF images on them.

DocumentTools.sense
The DocumentTools palette provides tools for creating and modifying 



documents.    There are pages within the palette for creating new documents 
(with certain properties set for you automatically depending on the type of 
document you will be creating); for changing the page size of a document 
(resize the document window and click a button to resize the page to match); 
and for changing page colors.

ElementsInText.sense
This document illustrates and describes the use of graphic elements and 

buttons embedded within text.    Any element embedded within text in a 
HyperSense document is a first-class object which may have its own script and 
other properties associated with it.

Eyes.sense
This one is just for fun, although it illustrates some useful concepts in 

SenseTalk scripting.

Help.sense
This is the HyperSense on-line manual.    It contains a complete reference to 

the features of HyperSense, as well as tutorial and introductory information.    In 
addition, as a HyperSense document itself, it illustrates the use of HyperSense 
to create a fully indexed reference work.    (Note: may not work well on small 
screens.)

HSTour.sense
The "HyperSense Tour" offers a quick introduction to HyperSense ± what it 



is; how a document is structured; how to use it.    This is a good place to start 
your exploration of HyperSense.    (Note: this document is not usable on small 
screens.)

HyperCalc.sense
A simple calculator implemented in HyperSense.    This document is 

accessed by a button on the frame of the DemoAddressBook.    Unlike most 
calculators, since this one is created in HyperSense you can easily rearrange 
the layout, or add additional buttons for specific functions that are important to 
you.

Importer.sense
This document is used to import HIFF files to create HyperSense documents.

A HIFF file is an intermediate representation of a HyperCard Stack, created on a 
Macintosh using the ConvertIt!Ô software from Heizer Software.    ConvertIt! is 
not included with the demo release of HyperSense.    (See the file 
ImportingStatus.rtf in the ReleaseNotes directory, and the portions of the online 
manual dealing with HyperCard importing for more information). 

Map.sense
The Map document (accessed from the first page of the DemoAddressBook) 

contains only one page, but illustrates one use of multiple layers on a page.    By
calling up the LayerPanel (type Command-Shift-L), you can see a list of all of the
layers on the page.    Clicking on the switches at the bottom of the page will 
alternately hide and show some of the layers.    Moving the hand cursor over 



one of the cities (when the Cities are showing) will display a different layer 
containing data about that city.    Pointing to the heading at the top of the page 
will display information about the County.    Clicking on the button labelled 
"Newspaper" will open another HyperSense document (Newsletter.sense).

Mathematics.sense
This example presents one idea for a simple arithmetic tutorial, with sound 

and graphic reinforcement.    For best effect, this document requires a NEXTSTEP
system with audio capabilities.    Created by Todd Nathan.

Newsletter.sense
This document is another example using multiple layers on a single page, 

and shows the potential for using HyperSense for simple layout applications 
(the capability of flowing text automatically from one field to another is planned 
for a future release).    With the LayerPanel open, you may Command-click on 
the names of the three layers (click while holding down the Command key) to 
hide and show the individual layers.    (Note: this document is too large to 
display properly on small screens.)

OtherTools.sense
This panel, accessed by selecting "Other Tools" from the Tools menu, is a 

multi-page palette of drag-and-drop tool elements for creating your own 
documents.    In addition, it is itself a fully-customizable HyperSense document.   
The Commands button at the top of the window will display several other 
buttons which make creating custom palettes easier (click anywhere outside 



these buttons to hide them again).

PasteMaster.sense
If you work with text at all, you'll find this to be a handy place to store 

frequently-used phrases or paragraphs, or for those times when you are 
juggling paragraphs and wish you had more than one pasteboard.    Simply copy
some text to the pasteboard (using Command-c from any application) and click 
one of the "Store" buttons.    To retrieve that piece of text later, click the 
corresponding "Use" button to restore it to the pasteboard; then paste it 
wherever you need it (using Command-v).    This little application is a perfect 
illustration of HyperSense's usefulness for creating small utility programs ± it 
was conceived, designed, created, and refined in about an hour.    [note: when 
running in Demo mode, anything stored into PasteMaster will be lost when the 
document is closed].

WindowFrame.sense
This document describes and illustrates the distinction between 

WindowFrames, Stacks, and Pages within a HyperSense document.


